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1 Introduction 

Thank you for purchasing and using the Intel® Server Boards. The System Event Log (SEL) Viewer can be used 

to display, clear, or save the SEL log on your server.  

 

The SEL Viewer utility provides the ability to view system event records stored on the server management 

storage device of a server. The Baseboard Management Controller (BMC) records the details about the 

system events in a log in flash memory. Each SEL entry is a single system event. 

•  Displays the SEL records in either a text or a hexadecimal format.  

•  Allows you to save SEL entries to a file.  

•  Allows you to load SEL entries from a server and displays their properties.  

 

The Intel® System Event Log (SEL) Viewer Utility is only supported on the following Intel Server products: 

•  Intel® Server Board based on Intel® Xeon® processor E5-1600/2600/4600 v2 product family 

•  Intel® Server Board based on Intel® Xeon® processor E5-2400 v2 product family 

•  Intel® Server Board based on Intel® Xeon® processor E5-2600 v3/v4 product family 

•  Intel® Server Board based on Intel® Xeon® processor E3-1200 v2/v3/v4 product family 

•  Intel® Server Board based on Intel® Xeon® processor E3-1200 v5 product family 

•  Intel® Server Board based on Intel® Xeon® PhiTM product family 

 

For the latest information on your server, refer to http://support.intel.com/support/motherboards/server/. 

http://support.intel.com/support/motherboards/server/
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1.1 Operating System Supported 

This version of the SEL Viewer utility runs on the following OSes. 

Table 1. Operating Systems Supported 

Platforms 

SELViewer  

utility 

version 

Operating Systems/Preboot environment supported 

•  Intel® Server Board based on Intel® Xeon® 

processor E5-1600/2600/4600 v2 product 

family 

•  Intel® Server Board based on Intel® Xeon® 

processor E5-2400 v2 product family 

•  Intel® Server Board based on Intel® Xeon® 

processor E5-2600 v3/v4 product family 

•  Intel® Server Board based on Intel® Xeon® 

processor E3-1200 v2/v3/v4 product family 

•  Intel® Server Board based on Intel® Xeon® 

processor E3-1200 v5 product family  

•  Intel® Server Board based on Intel® Xeon® 

PhiTM product family 

14.0 

EFI shell 

Windows 2016 (EM64T) 

Windows* Server 2012 Enterprise (32bit & EM64T) 

Windows Server 2012 R2 EM64T 

Windows Server 2008 Enterprise (32bit & EM64T) 

Windows Server 2008 R2 SP1 EM64T 

Windows Server 2003 Enterprise (32 bit SP2 & EM64T SP2) 

Windows 7 (32bit & EM64T) for Work Station SKU’s 

Windows PE 2.0 – built from Windows Vista, 32 bit  

Windows PE 2.1 – built from Windows Vista SP1 or                                

Windows Server 2008, EM64T) 

Windows PE 3.x (32bit & EM64T) 

Windows PE 4.x (32bit & EM64T) 

RHEL*6.x and 7.x (32 bit & EM64T)   

CentOS* 6.x (32 bit & EM64T) 

SuSE* 11  SP1/SP2/SP3 and 12.x ( 32 bit & EM64T) 

 

Note: SELViewer version may be different across different platforms. Download the supported SELViewer 

version and build for your platform from Intel Support website. Also refer to the release notes for known 

issues. 

1.2 Target Audience 
This User Guide is intended for Original Equipment Manufacturers and those who are responsible for 

configuring the system BIOS and Management Firmware settings on a Intel Server system. 

1.3 Glossary of Terms 
The following table lists the terminology used in this document and the description. 

Table 2. Glossary of Terms 
Term Definition 

BIOS Basic Input Output System 

BMC Baseboard management controller 

EPS External Product Specification 

IPMI Intelligent Platform Management Interface 

JRE Java* Runtime Environment 

LAN Local area network 

RAM Random Access Memory 

SEL System event log 
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1.4 Support Information 
World Wide Web 

http://support.intel.com/support/ 

For an updated support contact list, see http://www.intel.com/support/9089.htm/. 

http://support.intel.com/support/
http://www.intel.com/support/9089.htm/
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2 Using the Intel® SEL Viewer 

2.1 Installing the Intel® SEL Viewer 

To install the SEL Viewer Utility in EFI, do the following: 

1. Copy all the files in the SEL Viewer release directory for EFI to a USB flash drive, or create an 

EFI-bootable CD. 

2. Insert the removable media into the server. 

3. Boot the server and press the <F2> key when prompted to enter BIOS setup. 

4. Go to the Boot Manager menu and select the option to boot to EFI shell. 

5. At the EFI shell prompt, type fsn: , where n is the file system number corresponding to the 

device that contains the SEL Viewer utility files. 

To install the SEL Viewer Utility in Windows* with the standalone installation, do the following: 

 Prerequisites: Java* Runtime Environment (JRE) must be installed. 

1. Install JRE X32 version for supporting WinPE* 2.0 (32 bit) OS and JRE X64 version for 

supporting WinPE 2.1 (EM64T) OS. Installation of JRE in a USB pen drive should be performed 

on the same version of the operating system; for example, for JRE x32 version use windows 32-

bit OS and for JRE x64 version use Windows* 64-bit OS.  

2. In Windows*/WINPE* set the JRE path using PATH=%PATH%;<>:\bin (where <> is the USB 

directory shown on the cmd prompt such as D: or E: or the path where java is installed (for 

example, c:\Program Files\Java). 

3. While installing JRE on USB pen drive to support WinPE* 2.0 and WinPE* 2.1, change the 

installation directory USB pen drive (for example, g:\). 

4. Copy all files and subdirectories from the utility released location into a folder on the hard drive 

(for example, c:\Selview). 

5. Open a command prompt and change to that directory: 

a. For 32-bit Windows*/WINPE*, go to folder c:\Selview\Windows\x86\imbdriver. 

b. For 64-bit Windows*/WINPE*, go to folder c:\Selview\Windows\x64\imbdriver. 

6. Execute install.cmd as administrator. 

This installation script will install the Intel IPMI driver. If Microsoft IPMI driver is present, the 

Intel IPMI driver will not be installed on the system. 

7. To run the SEL Viewer Utility, open a command prompt, and change directory to the folder 

where the selview.exe file resides (for example, cd c:\Selview\windows\x86). 

You can now run the utility. 

To install the SEL Viewer Utility in Linux* 

 Prerequisites 

1. Java* Runtime Environment (JRE) must be installed. 

2. XServer must be running for the Intel® SEL Viewer GUI to work. 

3. In Red Hat* 6 OSes: 

a. If the utility fails with the error message:  

"Error while loading shared libraries: libncurses.so.5: cannot open shared object file: No such 

file or directory" 

 then install libstdc++-4.4.4-13.el6.i686.rpm and ncurses-libs-5.7-3.20090208.el6.i686.rpm 

from the OS CD itself using the following commands: 

#rpm -ivh libstdc++-4.4.4-13.el6.i686.rpm 

#rpm -ivh ncurses-libs-5.7-3.20090208.el6.i686.rpm 
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Example: 

rpm -ivh media\Packages\libstdc++-4.4.4-13.el6.i686.rpm 

b. If the utility fails with error message:  

"Error: /lib/ld-linux.so.2: Bad ELF interpreter: No such file or directory". 

It indicates the development and optional packages are not installed. Install the necessary 

packages accordingly. 

4. On RHEL* 6.4 (or above), CentOS* 6.x, UEFI aware Linux* or other Linux*: 

There might be a driver confliction between internal driver and kernel. You need to start up 

OpenIPMI driver and make sure "/dev/ipmi0" device is existed. 

For example, you can use the below command to start up OpenIPMI driver on RHEL* 6.4. 

#modprobe ipmi_devintf 

A. Regular Installation: 

i. Boot into Linux and unzip the SELViewer utility zip file into a folder on your hard drive.  

ii. Copy all files and subdirectories from the utility released location into a folder on the hard 

drive (for example, /home/Selview/Linux). 

iii. Open a command prompt and change to that directory (for example, cd 

/home/Selview/Linux). 

iv. Unzip selview.zip to get the executable. Use “chmod 755” to change executable and script. 

Type  

./selview” to run selviewer. 

B. RPM Installation: 

i. Boot into Linux* and unzip the SELViewer utility zip file into a folder on your hard drive. 

ii. Copy rpm from Linux/RPM folder to a local folder. 

iii. If there is another version already has been installed previously, uninstall that version first 

before installing the new version. 

iv. Install selviewer utility by using rpm -ivh selviewer-xxx.rpm. This will install the utility in 

/usr/bin/selview/ folder. 

v. In RHEL*/SLES* after installing the rpm, close the terminal from which rpm was installed 

and then execute the utility from a new terminal (for example, # selview). 

vi. Type selview to run selviewer. 

2.2 Launching the Intel® SEL Viewer 

To launch the SEL Viewer, do the following: 

1. Boot to the target OS.  

2. From the directory containing the SEL viewer files, launch the SEL viewer from the EFI shell using 

the following syntax: 

selview [/clear | {/save [filename] [/hex]} | /h | /?] 

Note: A hyphen (-) may be substituted for the forward slash (/). 

Examples: 

selview  

(This launches the graphical version of the SEL viewer.) 

selview /clear 

selview /save MyFileName /hex 

selview /h 
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2.3 Viewing SEL Records in Interpreted Text Format 

1. Launch the SEL Viewer. 

2. The graphical display will display all the SEL entries. The following example shows the text view. 

 
Figure 1: SEL Viewer Text View 

The EFI-based SEL Viewer’s main window is based on a multi-column display pane as shown in Figure 1. It 

displays all the SEL records and a pull-down menu used for selecting the main functions available in the 

utility.  

See Figure 2 for SEL Viewer Main Utility Window (Windows* & Linux* OSes). The default format in which 

information is displayed in interactive mode is the interpreted text format. 

 
Figure 2: SEL Viewer Main Window (Windows* & Linux* OSes) 
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The interpreted data is displayed in several columns as follows: 

 Serial No.: Serial number of the system events are displayed starting with 1, and increasing by 

one for each event.  

 Time Stamp. 

 Sensor Type and Number. 

 Event Description1 

 Generator ID. 

The bottom information pane shows the details on the highlighted SEL entry. Use the arrow keys to move up 

and down, or the Tab key to highlight a menu. In Linux*, the bottom information pane contains a statistics 

panel which holds a statistical table of events based on their Event Type (Critical, Warning, Informational, or 

Others). 

For information on using the menu items see section Viewing the Intel® SEL Viewer Information Window. 

2.4 Viewing SEL Records in Hex Format 

Highlight the View tab to choose how the SEL entries are displayed (raw hexadecimal format or plain text). 

Select the raw-hexadecimal format to view the SEL records in HEX format. 

The following screen shows an example of the SEL log in Hex format.  

 
Figure 3: SEL Log in Hex Format (EFI) 

                                                        
1 Based on the IPMI Specification, BIOS EPS 
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The following figure shows SEL records in Hex format (Windows* & Linux* OSes). 

 
Figure 4: SEL Records in Hex Format (Linux*) 

The abbreviations used in the raw Hex display are as shown in the following table. 

Table 3. Accronym Used in the Raw Hex Display 
Acronym Description 

RID Record ID 

RT Record Type 

TS Time Stamp 

GID Generator ID 

ER Event Message Format Revision 

ST Sensor Type 

SN Sensor Number 

EDIR Event Dir and Event Type 

ED1, ED2, ED3 Event Data 

MID Manufacturer ID 

OEM OEM Defined 

ExB1…ExB8 Extended Byte1…Extended Byte8  

Note: Supported only on:  

•  Intel® Server Board based on Intel® Xeon® processor E5-1600/2600/4600 v2 product family 

•  Intel Server Board based on Intel Xeon processor E5-2400 v2 product family 

•  Intel Server Board based on Intel Xeon processor E3-1200 v3/v4 product family 
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2.5 Viewing the Intel® SEL Viewer Information Window 

This option allows you to view/hide the SEL Information window. When you run the utility, by default, the 

SEL Info window is visible and the sub-menu is shown as Hide SEL Info Window.  

If you select Hide SEL Info Window, the SEL Info window is removed from the display area and the sub-

menu text changes to View SEL Info Window. You can again add the SEL Info window using this sub-menu.  

Hide SEL Info Window / View SEL Info Window option is currently disabled in Hex view of EFI-based SEL 

Viewer utility. The SEL Info window automatically goes off when you change from text view to hex view. In 

case of Linux*, this option is available under the SEL Menu item. 

2.6 Navigating the Intel® SEL Viewer Window 

To navigate the SEL Viewer window from the pull-down menu, use the arrow keys to move around the 

various menu items and the <Enter> key to select a particular menu item.  

A brief help message about the option selected from the menu is displayed in the tip-view window, which is 

displayed at the bottom of the main window for EFI-based SEL Viewer Utility. This feature is not supported 

by WinPE*-based SEL Viewer Utility.  

•  For WinPE*-based SEL Viewer Utility 

o Use <Alt> key to select the menu and use arrow keys to move around various menu items  

o Use <Enter> key to select a particular menu item.  

o A menu item can also be accessed by left clicking the mouse on the menu item. 

o In the display pane, use <Home> key selects the first record and <End> key selects the last record.  

The following table list the shortcut keys in the SEL Viewer. 

Table 4. Shortcut Keys of the WinPE*-based SEL Viewer Utility 
Utility Version Shortcut Keys Descriptions 

WinPE* 

<Alt>+<F> Open File menu. 

<Alt>+<S> Open SEL menu. 

<Alt>+<V> Open View menu. 

•  For EFI-based SEL Viewer Utility 

o Use <Tab> key to move between the display pane, information window at the bottom and pull-down 

menu. 

o The display pane supports arrow keys, <PgDn>, <PgUp>, <Home>, and <End> keys to move across 

the display pane. 

o Use <Home> key selects the beginning of the selected SEL entry in the display pane, and <End> key 

selects the end of the selected SEL entry in the display pane. 

o Use <F5> key to move forward between columns and <F6> to move backwards. 

o Use left arrow key to scroll to the left and right arrow key to scroll to right in display pane. 

When the utility is first invoked, it loads the SEL records from non-volatile storage on the server. A status 

box as shown in Figure 5 is displayed to indicate that the SEL Viewer is loading SEL records from the 

server.  
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Figure 5: Status Box 

•  For Window*/Linux*-based SEL Viewer Utility 

o Serial Numbers can be color coded based on the severity of a SEL Event.  

o A small panel is provided on the bottom right corner which has a statistical view of the SEL Records. It 

contains the count of the SEL events segregated based on the severity type (i.e., Informational, 

Warning, Critical, or Others). 

o In Linux*, the status message is displayed on the status bar of the Utility main window. 

2.7 Saving the Intel® SEL to a File 

You may want to save the SEL to a file for analysis, record keeping, or documentation of a system issue. 

There are two ways to save the SEL to a file (the Windows Preboot Environment* version is shown in this 

example): 

 To save the SEL, use the following command line syntax:  

In interpreted text format:  

selview /save MyFileName  

In hex format:  

selview /save MyFileName /hex 

 Use the File | Save menu option from the graphical SEL viewer window. 

To save the SEL data to a file with a .sel file name extension, either in interpreted text format or in 

raw hex format, depending on the mode in which records are currently displayed. 

2.8 Viewing the Intel® SEL from a File 

To view the SEL records that you previously saved to a file, use the File | Open menu option from the 

graphical SEL viewer window. 

To return to viewing the SEL records from non-volatile memory, use the SEL | Reload menu option. 

2.9 Checking the Intel® SEL Properties 

To check the SEL properties (number of entries, add/erase time, space available, and so on) in the SEL 

Properties dialog, use the SEL | Properties menu option from the graphical SEL viewer window. 

 
Figure 6: SEL Properties Dialog 
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Notes:  

•  The SEL viewer will display the Free Space Remaining in bytes. 

•  In Linux*, the SEL Properties dialog will not display Last Add Time and Last Erase Time. 

2.10 Clearing the Intel® SEL 

The SEL has a limited capacity. Refer to the Specifications in your server board product guide for the 

maximum number of records for server. After the SEL is full, subsequent system events will not be recorded 

and you will need to manually clear the SEL. There are two ways to clear the SEL (the Windows Preboot 

Environment* version is shown in this example): 

 Use the command line syntax:  selview /clear 

 Use the SEL | Clear menu option from the graphical SEL viewer window. 

2.11 Sorting the Intel® SEL Entries in the UI 

Use the SEL | Sort by option in the SEL Viewer main window to sort the SEL entries by different fields.  

This option, when selected, displays a list of fields by which the entries can be sorted. You can sort the 

records by Num, Time Stamp, Sensor Type and Number, Event Description, or Generator ID upon choosing 

the appropriate field.  

This option is not available if the SEL entries are displayed in hexadecimal mode.  

For Windows*/Linux* based SEL Viewer Utility, sorting can also be performed by clicking on the appropriate 

Column heading using a mouse (in case of text mode display). 

2.12 Go to Option (Windows*/Linux*-only Feature) 

Use the SEL | Go To option in the SEL Viewer main window to select a particular SEL entry given its Serial 

Number. You can enter the Serial Number of the SEL Entry in the textbox provided in the Go To dialog and 

the SEL Table on the Utility main window will be scrolled and that particular entry will be highlighted. Go To 

can be accessed by the shortcut <CTRL>+<G>. This feature is currently supported only on Windows* & 

Linux*. 

2.13 Getting Additional Help 

If you need help on the command line syntax or any of the graphical menu items that are not described in 

this User Guide, use the online help. There are two ways to get help: 

 Use the command line syntax:  selview /help 

 Use the Help menu option from the graphical SEL Viewer window. 

 

2.14 Uninstalling the Intel® SEL Viewer 

To uninstall the SEL Viewer Utility in EFI, do the following: 

1. Go to the directory in the command line prompt, where all your utility files are copied from the 

utility released location. 
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2. Run cd .. on a command line prompt. This will take you to a directory one level below. 

3. Remove all the directories including subdirectories in the current directory where you are. This 

leads to the uninstallation of the utility files. 

To uninstall the SEL Viewer Utility in Windows*, do the following: 

The utility files should be manually removed, if they were installed stand alone. 

1. Go to the directory in the command line prompt, where all your utility files are copied from the 

utility released location. 

2. Run cd .. on a command line prompt. This will take you to a directory one level below. 

3. Remove all the directories including subdirectories in the current directory where you are. This 

leads to the uninstallation of the utility files. 

To uninstall the SEL Viewer Utility in Linux*, do the following: 

1. Go to the directory in the command line prompt, where all your utility files are copied from the 

utility released location. 

2. Run cd .. on a command line prompt. This will take you to a directory one level below. 

3. Remove all the directories including subdirectories in the current directory where you are. This 

leads to the uninstallation of the utility files. 
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Appendix Exit Error Codes 

The command line version of the SEL Viewer may be used in a script to automate the tasks of saving the SEL, 

clearing the SEL, or searching the SEL. The following list of exit codes may be useful in the error handling 

section of the script. 

 

Table 5. Exit Error Codes 
Integer Value Interpretation 

0 Successful termination 

1 Unable to clear SEL 

2 SEL log is empty 

3 Unable to read SEL entries 

4 Unable to create SEL file 

5 Invalid invocation 

6 IPMI Driver initialization failed 

7 Unable to initialize SEL Viewer 

8 Unknown error 

 


